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การเรียกใช้โปรแกรม SketchUp 2018

หลงัจากติดต้งัโปรแกรม SketchUp สามารถเรียกใชโ้ปรแกรมโดยมีข้นัตอนดงันี้ 

1. คลิกเข้าสู่โปรแกรม SketchUp 2018 > SketchUp หรือ ดบัเบิลคลิกไอคอน SketchUp 2018 ที่หน้าจอ (Desktop)

2. เม่ือเปิดโปรแกรมจะปรากฏไดอะลอ็กบ๊อกซ์ “Welcome to SketchUp” ซ่ึงเป็นการตั�งค่าการท างานเบื�องต้นของ
การท างานหากเข้าสู่โปรแกรมเลือก Start using SketchUp 

ในขั้นตอนน้ีผูใ้ชส้ามารถกรอกช่ือผูใ้ชแ้ละรหสัท่ีไดจ้ากตวัแทนจ าหน่ายเม่ือสั่งซ้ือโปรแกรม โดยการคลิก

ไปท่ี Add License กรอกขอ้มูลทะเบียนผูใ้ช ้หากไม่กรอกทะเบียนผูใ้ช ้จะยงัคงใชโ้ปรแกรมในรุ่นทดลองใช ้ซ่ึงจะมี

บางค าสั่งถูกลดทอนลง 
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นอกจากนั้นยงัสามารถตั้งค่าหน่วยวดัท่ีใชใ้นการสร้างโมเดลวา่จะใชรู้ปแบบใด เช่น เมตร ฟุต น้ิว โดยการเลือกท่ี 

Template จากนั้นเลือกหน่วยวดั 

เม่ือเลือก Start using SketchUp จะเข้าสู่หน้าจอท างานของโปรแกรม (หมายเหตุ: สีของฉากหลงัเปล่ียนไปตาม

การตั�งค่าหน่วยวดัซ่ึงสามารถตั�งค่าได้อีกครั� ง) 
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3. เม่ือเขา้สู่การท างานของโปรแกรม สามารถเรียกเคร่ืองมือ (Tools) เพื่อสร้างช้ินงาน โดยไปท่ี View > Toolbar >
Large Tool Set เคร่ืองมือส าหรับการสร้างช้ินงาน จะปรากฏในหน้าต่างการท างาน นอกจากการเรียกชุดคําสั่งส าหรับ 

ช้ินงาน แลว้ยงัสามารถเรียกเคร่ืองมืออ่ืน ๆ เพื่อใหก้ารท างานมีความรวดเร็วมากยิง่ขึ้น  
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หน้าต่างของโปรแกรม SketchUp 2018
ก่อนท่ีจะเร่ิมท างานกบั SketchUp 2018 เรามาท าความรู้จกักบัส่วนประกอบของโปรแกรม ซ่ึง 

SketchUp มีส่วนประกอบท่ีเรียบง่าย ดูไม่ซบัซอ้น 

หน้าจอหลกั (Main Screen) 

 ไตเติ้ลบาร์ (Title bar) : แสดงช่ือไฟลที์่กําลงัใชง้านอยู ่ 

 เมนูบาร์ (Manu bar) : แถบรวมค าสั่งทั้งหมด  

 ทูลบาร์ (Toolbar) : แสดงเคร่ืองมือหลกัในการวาดและปรับแต่งโมเดล  
 พื้นที่การท างาน (Drawn area) : เนื้อท่ีท างาน แสดงผลเป็น 3 มิติ  
 จุด Origin และแกนวาด : จุดเริ่มตน้และแกนวาด 3 แกน ไดแ้ก่ แกนสีแดง, เขียว และน้ าเงิน  

 ส่วนแสดงข้อมูลโมเดล : แสดงขอ้มูลโมเดล วธีิใชเ้คร่ืองมือต่าง ๆ  
 Measurement bar : ใชแ้สดงขนาด ระยะทาง และใชส้ าหรับพิมพก์ าหนดค่า ซ่ึงหน่วยวดัจะเปล่ียนแปลงไปตาม 

เคร่ืองมือที่ใชอ้ยู ่
 ไดอะลอ็กบ็อกซ์ (Dialog Box) : เคร่ืองมือปรับแต่งแกไ้ขรายละเอียดการท างานเพื่อเพิ่มความสามารถในหลาย
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ดา้น เช่น การตั้งค่าแสงสว่าง (Shadow Setting) การเลือกวตัถุสําเร็จรูป (Component) การใส่สีและพื้นผวิ

 (Paint Bucket) เป็นตน้ 

เส้นแกน (Axes) 
การท างานกบัโมเดล 3 มิติ นอกจากมุมมอง ในการดูต าแหน่งต่าง ๆ แลว้ แกนก็ถือวา่เป็นเร่ือง ท่ีจ  าเป็นตอ้ง

ใช ้เพราะเป็นตวัช่วยในการวางต าแหน่ง และก าหนดทิศทางต่าง ๆ ขณะวาด  
ในการสร้างโมเดลอาคารสถานท่ี แต่ละแกนจะแสดง 

ทิศทางต่างๆ กนั ดงัน้ี 

 แกน x เส้นทบึสีแดง จะโยงไปทางทิศตะวนัออก
 แกน x เส้นประสีแดง จะโยงไปทางทิศตะวนัตก

 แกน Y เส้นทบึสีเขียว จะโยงไปทางทิศเหนือ

 แกน Y เส้นประสีเขยีว จะโยงไปทางทิศใต้

 แกน Z เส้นทบึสีน ้าเงนิ จะโยงขึ้นไปบนทอ้งฟ้ า

 แกน Z เส้นประสีน ้าเงนิ จะโยงลงไปใตร้ะดบัพ้ืนดิน

จะเห็นวา่เสน้แกนจะมีส่วนท่ีเป็นเสน้ทึบและเสน้ประ และมีส่วนท่ีตดักนัจะเรียก  
จุดนั้นว่าจุดฐานรูปทรงอา้งอิง  (Shape Inference) ของแกน หรือ จุด Origin ซ� ึงเป็ นจุดเร�ิมตน้ ในการวาดช้ินงาน 

ต าแหน่งอ้างองิบนโมเดล 
ขณะท่ีใชเ้คร่ืองมือวาดรูปทรงต่าง ๆ น้ัน จะเห็นขอ้ความแสดงต าแหน่งของส่วนต่าง ๆ ภายในโมเดล

 เรียกว่า ต ำแหน่งอ้างอิง เม่ือเล่ือนเมาส์ไปบนต าแหน่งต่างๆ เมาส์จะแสดงสญัลกัษณ์ ท่ีแตกต่างกนั และมี 

ทูลทิป (Tooltips) บอกต าแหน่งใหด้ว้ย ต าแหน่งอา้งอิงในโมเดลน�ันแบ่งออก เป็น 3 ประเภท ไดแ้ก่ จุดอา้งอิง 

(Point Inference), เสน้แนวอา้งอิง (Linear Inference) และรูปทรงอา้งอิง (Shape Inference) 

จุดอ้างองิ (Point Inference) 

เม่ือเล่ือนเมาส์ไปบนโมเดล จะเห็นจุดอา้งอิงแสดงในต าแหน่งต่าง ๆ ดงัน้ี 
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Endpoint : เคอร์เซอร์อยูใ่นต าแหน่งปลายเส้นหรือปลายเส้นขอบของ
วตัถุ 

Midpoint : เคอร์เซอร์อยูใ่นต าแหน่งก่ึงกลางเส้น หรือก่ึงกลางเส้นขอบ
ของวตัถุ 

Intersection : เคอร์เซอร์อยูใ่นต าแหน่งท่ีมีการตดักนัของเส้น 

On Face : เคอร์เซอร์อยูใ่นต าแหน่งบนพื�นผวิของวตัถุ 

On Edge : เคอร์เซอร์อยูใ่นต าแหน่งบนเส้นขอบของวตัถุ 

เส้นแนวอ้างองิ (Linear Inference) 

On Axis : เสน้มีสีแตกต่างกนั 3 สี  
สีแดง วางตวัในแนวแกน X  
สีเขยีว วางตวัในแนวแกน Y  
สีนํ�าเงนิ วางตวัในแนวแกน Z  
Parallel to Edge : วาดเสน้โดยขนานไปกบั วตัถุท่ีอย่ใูกล้  
Perpendicular to Edge : ขณะวาดเสน้ตั้งฉากกบัเสน้ขอบท่ีเราเริ่มตน้วาด  
Form Point : ขณะท่ีวาดเสน้ต าแหน่งเคอร์เซอร์ ไปอา้งอิงกบัต าแหน่งของเสน้อื่น ๆ จะเกิดเป็นเสน้ประ 
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การบันทกึไฟล์งาน 

ถ้าต้องการเกบ็ไฟลไ์ว้หลงัจากสร้างงานแล้ว สามารถบนัทึกไฟลเ์กบ็ไว้เรียกใช้ภายหลงัได้

โดยไฟลท่ี์ไดจ้ะมี นามสกลุ .skp มีขั�นตอนดงันี�
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การท างานกบัวตัถุ 3 มิตินั�นจะมีมุมมองท่ีรอบดา้นแตกต่างจากวตัถุ 2 มิติ ดงันั้นเคร่ืองมือเก่ียวกบัมุมมอง 

ชิ้นมากต็อ้งมีหลายอย่าง เพื่อความเหมาะสมกบัการดูช้ินงานมาของแต่ละมุม โปรแกรม SketchUp มีเคร่ืองมือ

มุมกลอ้งซึ�งจ าลองมุมมองเหมือน อยู่ในสภาพแวดลอ้มของช้ินงานจริง เช่น การมองดูหรือการเดินผ่านช้ินงานท่ี 

เป็นสถานท่ี 

มุมมองมาตรฐาน Standard View 

ในพื้นท่ี 3 มิติจะมีมุมมองมาตรฐานในการมองช้ินงานอยู ่7 มุม ไดแ้ก่ 
 Top : ดา้นบน

 Bottom : ดา้นล่าง (ขา้งใต)้

 Front : ดา้นหนา้

 Back : ดา้นหลงั

 Left : ดา้นซา้ย

 Right : ดา้นขวา

 ISO : Isometric หรือมุมมองแนวเอียงท่ีท าใหเ้ห็นรูปทรงโดยรวมของช้ินงานได้

การเลอืกมุมมองมาตรฐานอย่างรวดเร็ว 

ในการมองช้ินงานมุมต่าง ๆ นั�นเราสามารถใชเ้คร่ืองมือหมุนมุมมอง เพื่อมองรอบชิ้นงานไดอิ้สระ แต่ 

มุมมองมาตรฐานมีประโยชนส์ าหรับการตรวจสอบช้ินงานมาในแต่ละดา้นอยา่งเท่ียงตรง และใชใ้นการน าเสนองาน

 เช่น การออกแบบสินค้าหรือสถานท่ีต่าง ๆ การเลือกมุมมองมาตรฐาน ท าได้ดงันี�
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1. เลือกเมนู Camera จากแถบเมนูหลกั และเลือกมุมมองจากเมนูยอ่ย Standard Views

2. พื้นท่ีท างานจะเปล่ียนเป็นมุมมองท่ีเลือกไวต้ามภาพตวัอยา่ง
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การเคลือ่นมุมมองรอบวตัถุ Orbit 

เคร่ืองมือ Orbit มีไวส้ าหรับการหมุนมุมมองรอบช้ินงานในลกัษณะการโคจรรอบ ๆ นบัวา่ เป็นเคร่ืองมือท่ี

จ าเป็นตอ้งใชต้ลอดเวลาในการสร้างโมเดล 3 มิติ และเคร่ืองมือ Orbit น้ีมกัใชค้วบคู่กบัเคร่ืองมือ Pan ซ่ึงจะแนะน า

ในหวัขอ้ต่อไป 

การมองรอบ ๆ ช้ินงานด้วย Orbit  
การเรียกใชเ้คร่ืองมือ Orbit นั้นทําใดจ้ากการเรียกใชเ้มนู และการใชเ้มาส์เพื่อความรวดเร็ว ดงันี้ 

1. คลิกเลือกเคร่ืองมือ Orbit บน Toolbar

2. ใชเ้คร่ืองมือ Orbit คลิกเพื่อหมุนมุมมองช้ินงานไดร้อบ 360 องศา ส่ิงท่ีหมุนคือมุมมองของเรา แต่ไม่ใชว้ตัถุ
ท่ีถูกหมุน
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การเลือ่นมุมมองแนวราบ Pan 

เคร่ืองมือ Pan ใชส้ าหรับการเล่ือนมุมมองแนวราบโดยไม่หมุนมุมมอง จะเห็นไดว้า่หนา้ท่ีของ Pan และ 
Orbit นั้นเป็นการจดัการมุมมองช้ินงานท่ีต่างแนวกนั แต่ตอ้งใชคู้่กนัเสมออยา่งหลีกเล่ียงไม่ได ้ดงันั้น 2 เคร่ืองมือน้ี
จึงเป็นเคร่ืองมือท่ีเราเรียกใชไ้ดทุ้กเวลาโดยไม่จ  าเป็นตอ้งคลิกเลือกเคร่ืองมือจาก Toolbar ก่อนทุกคร้ัง  
เรามาดูวธีิใชง้าน Pan Tool ทั้งจากการคลิกท่ี Toolbar และการใชง้านดว้ยเมาส์ 

1. จากตวัอยา่งช้ินงานจะอยูเ่รียงกนัในแนวหนา้กระดาน

2. คลิกเลือกเคร่ืองมือ Pan บน Toolbar

3. ใชเ้คร่ืองมือ Pan คลิกและเล่ือนมุมมองในแนวราบเพื่อท างานกบัช้ินงานแต่ละช้ินได ้การเล่ือนน้ีเป็นการ

เล่ือนมุมมอง แต่วตัถุไม่มีการเคล่ือนยา้ยแต่อยา่งใด
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การขยายมุมมอง Zoom 
เคร่ืองมือ Zoom นบัวา่เป็ นเคร่ืองมือจดัการมุมมองท่ีมีหนา้ท่ีสาํคญั คือการยอ่และขยายมุมมอง เพื่อท างาน 

กบัชิ้นงานในระดบัภาพรวมหรือในรายละเอียดยอ่ย ๆ ได ้เคร่ืองมือ Zoom ไม่เพียงแต่ใชใ้นการยอ่ขยายมุมมอง 

เท่านั้น แต่ยงัใชเ้ปล่ียนมุมกลอ้งไดอี้กดว้ย 

การเรียกใช้เคร่ืองมอื Zoom  
การเรียกใชเ้คร่ืองมือ Zoom จาก Toolbar มีดงัน้ี 

 คลิกเล่ือนไปทางดา้นบนเป็นการขยายมุมมองช้ินงานจะดูใกลแ้ละใหญ่ข้ึน

 คลิกและเล่ือนไปทางดา้นล่างเป็นการยอ่มุมมอง ช้ินงานจะดูไกลออกไปและเล็กลง

 หากดบัเบิลคลิกเคร่ืองมือ Zoom ไปท่ีวตัถุใด วตัถุนั้นจะถูกจดัใหอ้ยูต่รงกลาง
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Zoom Window 
Zoom Window เป็นเคร่ืองมือท่ีอยู่ใกลเ้คียงเคร่ืองมือ Zoom และใชง้านใกลเ้คียงกนัดว้ย เพียงแต่เคร่ืองมือ 

Zoom Window จะใหล้ากพ้ืนท่ีท่ีตอ้งการจะขยายมุมมองโดยเฉพาะ วธีิใชแ้ละตวัอย่างผลลพัธ์มีดงันี้ 

ลากพื้นท่ีท่ีตอ้งการขยายมุมมอง ผลลพัธ์ คือมุมมองจะถูกขยายในบริเวณท่ีลากพื้นท่ีจนเตม็หนา้จอการท างาน 

Zoom Extents  
Zoom Extents มีหนา้ท่ีขยายมุมมองเพื่อให้เห็นช้ินงานทั้งหมดบนพื้นท่ีท างาน โดยมีมุมมองท่ีใหญ่ท่ีสุดเท่าท่ีจะ

ครอบคลุมช้ินงานทั้งหมดนั้น 

ช้ินงานทั้งหมดจะถูกขยายจนเตม็พื้นท่ีการท างาน 

การเลือกส่วนประกอบโมเดล สามารถเลือกดว้ยการใชเ้คร่ืองมือ Select โดยท าไดห้ลายวธีิข้ึนอยูก่บัลกัษณะ

งาน ดงันั้นจึงจ าเป็นตอ้งรู้จกัเทคนิคในการใชเ้มาส์ และคียบ์อร์ด เพื่อเลือกส่วนประกอบท่ีตอ้งการ 

การเลอืกด้วยการคลกิเมาส์หลายคร้ัง 

ดว้ยการคลิกเมาส์อยา่งเดียว เราสามารถเลือกส่วนต่างๆ ของวตัถุได ้แต่เราควรทราบก่อนวา่วตัถุช้ินหน่ึง

ประกอบดว้ยอะไรบา้ง 
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เม่ือทราบองคป์ระกอบของวตัถุแลว้ การเลือกส่วนต่างๆ ของวตัถุดว้ยเมาส์ มีดงัน้ี 

การคลิก 1 คร้ัง บนดา้นใดดา้นหน่ึง  
จะเป็นการเลือกเฉพาะพื้นผวิของดา้นนั้น 

และจะปรากฏไฮไลทพ์ื้นผวิท่ีเลือก 

การคลิก 2 คร้ัง หรือดบัเบิลคลิก  
     จะเป็นการเลือกพื้นผวิและเส้นขอบพื้นผวินั้น 

     จะมีไฮไลทป์รากฏทั้งพื้นผวิ และเส้นขอบ 

 การคลิก 3 คร้ัง หรือทริปเปิลคลิก  
จะ เป็นการเลือกวตัถุทั้งช้ิน หรือมีความหมายวา่ 
เลือกพื้นผวิและเส้นขอบทุกดา้นท่ีเช่ือมต่อกนั  
ของวตัถุช้ินนั้น จะมีไฮไลทป์รากฏทั้งช้ินวตัถุ  
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การเลอืกวตัถุหลายช้ินด้วยการลากพืน้ทีเ่มาส์ 

การลากพื้นท่ีเมาส์เพื่อเลือกวตัถุหลายชิ้นนั้นมีวธีิท่ีสะดวกรวดเร็ว เพียงเราเขา้ใจในหวัขอ้น้ ีเรากเ็ลือก

วตัถุได ้อยา่งง่าย 

การลากพื้นท่ีดว้ยเมาส์จากซา้ยไปขวา จะปรากฏกรอบส่ีเหล่ียมเส้นทึบซ่ึงจะเป็นการเลือกวตัถุท่ีอยู่
ภายในกรอบการลากพื้นท่ีเท่านั้น วตัถุใด ท่ีไม่อยูใ่นกรอบเตม็ช้ินก็จะไม่ถูกเลือก 

การลากพื้นท่ีดว้ยเมาส์จากขวาไปซา้ย จะปรากฏกรอบส่ีเหลี่ยมเสน้ประ ซ่ึงจะเป็นการเลือกวตัถุท่ีกรอบ 

เสน้ประนั้นพาดโดน แมไ้ม่ไดค้รอบวตัถุท้ังช้ิน แต่ถา้กรอบเสน้ประไปถึง วตัถุนั้นกจ็ะถกูเลือกดว้ย 
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การเลอืกวตัถุทั้งหมดและการยกเลกิการเลอืก  
เราสามารถเลือกวตัถุทั้งหมดในไฟลโ์ครงการท่ีเปิดอยูข่ณะนั้นได ้และยกเลิก การเลือกทั้งหมดได ้เช่นเดียวกนั 
การเลือกทั้งหมด กดปุ่ม <Ctrl> + A บนคียบ์อร์ด หรือเลือกเมนู Edit >Select All  

เคร่ืองมือลบวตัถุ Eraser 

เคร่ืองมือ Eraser    ใชล้บเส้น, ช้ินส่วน, กรุ๊ป หรือคอมโพเนนต ์นอกจากน้ียงัใชซ่้อนเส้นท่ีไม่ตอ้งการ 

หรือทําพ้ืนผวิใหเ้รียบขึ้นได ้แต่ไม่สามารถลบพื้นผวิได ้

การลบองค์ประกอบของวัตถุ 

ใชเ้คร่ืองมือลบคลิกท่ีส่วนใดส่วนหน่ึงของวตัถุ เช่น เส้นขอบ และปล่อย เพื่อลบส่วนนั้น 
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ใชเ้คร่ืองมือลบคลิกคา้ง และลากผา่นไปยงัส่วนต่าง ๆ ท่ีจะลบ ก่อนปล่อยเมาส์เพื่อลบส่วนท่ีเลือกไว ้ 

การลบขอบวตัถุ 
โดยทัว่ไปวตัถุจะมาพร้อมกบัเส้นขอบเพื่อใหพ้ื้นผวิเป็นส่วนท่ีปิด แต่พื้นผวิก็สามารถอยูไ่ดโ้ดยไม่มีเส้น

ขอบ ซ่ึงจะท าใหพ้ื้นผวิดูเรียบข้ึน เราสามารถลบขอบออกโดยไม่ท าใหพ้ื้นผวิวตัถุหายไปได ้

 เลือกเคร่ืองมือลบ และกดปุ่ม      คา้ง ขณะคลิกเลือกเส้นขอบท่ีตอ้งการลบ ซ่ึงเลือก ไดค้ร้ังละหลาย
เส้น 

 การท าใหพ้ื้นผวิมีเส้นขอบกลบัมาเหมือนเดิม ใหใ้ชเ้คร่ืองมือยางลบเช่นเดิม และกดปุ่ม  +  

ขณะลากเมาส์ผา่นพื้นผวิ และปล่อย 
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เคร่ืองมือเทสีพื้นผวิวตัถุ Paint Bucket 

โปรแกรม SketchUp ก าหนดพื้นผวิวตัถุใหมี้สีและคุณสมบติัต่าง ๆ ได ้เช่น โปร่งใส เป็นตน้ ซ่ึงจะใช้

เคร่ืองมือช่ือ Paint Bucket ในการท างาน 

1. คลิกเลือกเคร่ืองมือ Paint Bucket

2. หนา้ต่าง Materials จะปรากฏข้ึนมา ซ่ึงเป็นท่ีรวมสีและพื้นผวิเพื่อเลือกใช้

3. เลือกสีท่ีตอ้งการใช้ ในตวัอยา่งจะเลือกสีแดง
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4. คลิกเลือกพื้นผวิส่วนท่ีตอ้งการ เพื่อเปล่ียนสีวตัถุช้ินหน่ึง อาจจะมีพื้นผวิหลายส่วนท่ีไม่ไดเ้ช่ือมต่อกนั

ท าใหต้อ้งคลิก เทสีในแต่ละส่วนเอง

การใส่สีพืน้ผวิให้กบัวตัถุ  
การใส่คุณสมบติัพ้ืนผวินั้น ท าโดยวธีิเดียวกบัการเลือกสีแลว้เทบนพื้นผวิ เพียงแต่เลือก ในหมวดพื้นผวิเท่านั�น

ในตวัอย่างนี้จะท าการก าหนดใหก้ระจกรถยนตมี์สีโปร่งใส โดยมีขั�นตอนดงันี�



20 

  คลิกเทสีบนพ้ืนผวิท่ีตอ้งการ ไดแ้ก่ กระจกรอบคนัรถ หมุนวตัถุดว้ยเคร่ืองมือ Orbit หรือ   

                  คลิกเมาส์ปุ่มกลางแลว้หมุน 

เทสีกบักระจกอีกดา้นจนรอบคนั

ขั�นตอนที�  2

เลือกตวัเลือกท่ีมีช่ือว่า Glass ซึ� งพื�นผวิวตัถุไว้มีสีต่าง ๆ 
เลือกใชต้ามท่ีชอบได ้กบัวตัถุซ่ึงหมวดของพื้นผวิ

โปร่งใสจะมีชื่อวา่ Translucent

ข�ันตอนที�  1

ในหนา้ต่าง Materials จะมีการแบ่ง

หมวดหมู่ ในรายการ Drop down list

ขั�นตอนที�  3 ขั�นตอนที�  4

ขั�นตอนที�  5
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ชุดเคร่ืองมือ Drawing 

ชุดเครือ่งมือ Drawing จะแสดงรวมอยูบ่นแถบเครื่องมือ Large Tool Set หากตอ้งการ แสดงชุดเครื่องมือ
 Drawing ขึ้นมาต่างหาก ใหค้ลิกเมนู View > Toolbar > Drawing ซ่ึงจะมีเครือ่งมือสําหรับวาดภาพในแนวระนาบ 

ดงันี้ 

เคร่ืองมอืวาดเส้นตรง Line 

เส้นเป็นองคป์ระกอบพื้นฐานของวตัถุต่าง ๆ เราสามารถวาดเส้นบนพื้นผวิวตัถุ หรือบนพื้นท่ีวา่งก็ได ้
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การวาดเส้นท่ีต่อเน่ืองกนัไปเร่ือย ๆ จนส้ินสุดท่ีจุดเร่ิมตน้จะเป็นการสร้างพื้นท่ีปิด ซ่ึงสามารถใชเ้ป็นวตัถุ 

เพื่อสร้างงานต่อไปได ้
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เคร่ืองมอืวาดเส้นอสิระ Freehand 

เคร่ืองมือวาดเสน้อิสระมีไวใ้ชว้าดเสน้ดว้ยมือ (เมาส์) ของเราเอง โดยท่ีไม่จําเป็นตอ้งเป็นรูปทรงเรขาคณิต

 และไม่ตอ้งค านึงถึงปัจจยัใด ๆ เคร่ืองมือวาดเสน้อิสระมีช่ือว่า Freehand 

การแก้ไขรูปทรงอสิระ 
เม่ือวาดรูปทรงอิสระข้ึนมาแลว้ รูปทรงนั้นจะมีโครงสร้างเป็นเส้นยอ่ย ๆ หลายส่วนท่ีต่อกนัจนไดรู้ปทรงท่ี

เราวาด โดยปกติเม่ือเลือกส่วนใดส่วนหน่ึงของรูปทรงอิสระ จะเป็นการเลือก วตัถุทั้งช้ิน หากตอ้งการแกรู้ปทรง

บางส่วน จะตอ้งท าการแยกส่วนเส้นต่าง ๆ หรือเรียกวา่ การระเบิด (Explode Curve) 

เคร่ืองมือวาดรูปทรงส่ีเหล่ียม Rectangle 

ส่ีเหล่ียมมุมฉากท่ีสร้างบนโปรแกรม SketchUp จะประกอบไปดว้ย พื้นผวิท่ีเกิดจาก เส้นตรง 4 เส้นเช่ือมต่อ

กนั ซ่ึงการสร้างส่ีเหล่ียมดว้ยเคร่ืองมือ Rectangle  
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การวาดรูปทรงส่ีเหลีย่มด้วยการก าหนดขนาดทีแ่น่นอน 
           หากตอ้งการสร้างส่ีเหลี่ยมท่ีมีขนาดดา้นกวา้งและยาวท่ีตอ้งการ เราสามารถก าหนดค่าเหล่านั้นไดอ้ย่างแม่นย า 

 ขณะ สร้างไดด้งันี้ 

ขณะลากพื้นท่ีพิมพค์่าความกวา้งและความยาวตามตอ้งการ เช่น 5m, 5m คือ ก าหนดความกวา้ง 5 เมตร ยาว 

5 เมตร 

การวาดรูปทรงส่ีเหลีย่มหมุนระนาบ  Rotated Rectangle  
เป็นเคร่ืองมือใหม่ในเวอร์ชั่น 2018 สามารถสร้างรูปทรงส่ีเหลี่ยมในลกัษณะหมุนระนาบไดด้งัน้ ี

1. คลิกเพื่อก าหนดมุมแรกของส่ีเหล่ียม

2. เล่ือนเคอร์เซอร์ของไมโ้ปรแทรกเตอร์ เพื่อก าหนดทิศทางของมุม
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3. คลิกเพื่อตั้งค่ามุมท่ีสอง เล่ือนเคอร์เซอร์เพื่อก าหนดความยาวของมุม และคลิกเพื่อตั้งค่ามุมท่ีสาม เป็นมุม

สุดทา้ย

4. เสร็จส้ินการสร้างรูปทรงส่ีเหล่ียมหมุนระนาบ
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เคร่ืองมอืวาดรูปวงกลม 

วงกลมท่ีสร้างข้ึนบนโปรแกรม SketchUp เกิดจากการเรียงต่อกนัของเส้นตรงลอ้มรอบ เป็นรูปวงกลม ซ่ึง

สามารถก าหนดจ านวนเส้นท่ีเรียงต่อกนั และความยาวรัศมีของวงกลมได ้เราจะใชเ้คร่ืองมือ  Circle สร้างวงกลม

และพื้นผวิบนระนาบ ซ่ึงท าได ้2 วธีิ คือ การสร้างพื้นผวิวงกลมดว้ยการลากเมาส์ และการก าหนดขนาดท่ีแน่นอน 

การวาดวงกลมด้วยการก าหนดขนาดทีแ่น่นอน 
เน่ืองจากวงกลมใน SketchUp เกิดจากการเรียงต่อกนัของเส้นตรงลอ้มกนัเป็นวงกลม ดงันั้นขณะท่ีสร้างวงกลมก็

สามารถก าหนดจ านวนเส้นตรงท่ีประกอบข้ึนเป็นวงกลมได ้โดยค่าเร่ิมตน้ก าหนดไวท่ี้ 24 เส้น และก าหนดความยาว

รัศมีของวงกลมตามตอ้งการ โดยการก าหนดขนาดต่าง ๆ ของวงกลม ไดด้งัขั้นตอนต่อไปน้ี 

1. คลิกเลือกเคร่ืองมือสร้างวงกลม และคลิกเพื่อสร้างบนพื้นท่ี แต่ยงัไม่ตอ้งคลิกเพื่อปิดการสร้าง

2. พิมพค์่ารัศมี เช่น 5m คือ 5 เมตร ซ่ึงค่าจะแสดงดา้นล่างขวาของหนา้จอ และกด <Enter>

3. พิมพค่์าจ านวน Sides หรือจ านวนส่วนยอ่ยของเสน้ขอบรอบวง ตามดว้ย s และกด <Enter>

4. เม่ือก าหนดเสร็จจะไดว้งกลมท่ีมีรัศมีและจ านวน Sides ของเส้นรอบวงตามตอ้งการ
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เคร่ืองมอืวาดรูปทรงหลายเหลีย่ม Polygon 

รูปทรงหลายเหล่ียม คือรูปทรงท่ีนอกเหนือจากส่ีเหล่ียม ซ่ึงเราก าหนดจ านวนเหล่ียม หรือดา้นเองได ้ตั้งแต่ 3 

เหล่ียมไปจนถึงจ านวนเหล่ียมมากกวา่ 10 ดา้น ก็สามารถท าได ้เคร่ืองมือวาดรูปทรงหลายเหล่ียม คือ Polygon 

การวาดรูปทรงหลายเหลีย่ม 

เคร่ืองมือ   Polygon โดยมีวธีิสร้างดงัน้ี 
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การแก้ไขรูปทรงด้วยหน้าต่าง Entity Info  
เราสามารถแกไ้ขรูปทรงท่ีไดส้ร้างไปแลว้ ดว้ยการเรียกหนา้ต่างคุณสมบติัของรูปทรง หรือ Entity Info ตามขั้นตอน

ต่อไปน้ี 
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เคร่ืองมอืวาดเส้นโค้ง Arc 

การวาดเส้นโคง้จะใชเ้คร่ืองมือ คลา้ยกบัการวาดเส้นตรง แต่สามารถปรับเส้นโคง้ขนานกบัแนวเส้นตรงท่ีวาดไว้

เป็นเส้นฐานในตอนแรก โดยความโคง้มากนอ้ยนั้นข้ึนอยูก่บัระยะห่างระหวา่ง โคง้กบัเส้นตรงท่ีวาด หรืออาจจะวาด

เป็นเส้นโคง้ท่ีต่อเน่ืองกนัเป็นรูปทรงท่ีมีพื้นผวิก็ไดเ้ช่นกนั เคร่ืองมือวาดเส้นโคง้มีอยู ่4 เคร่ืองมือ ไดแ้ก่ 

การวาดเส้นโค้งด้วยเคร่ืองมอื Arc 

เคร่ืองมือ Arc เป็ นเคร่ืองมือใชส้ําหรับสร้างเสน้โคง้แบบก าหนดมุมได ้มีขั้นตอนดงันี้ 
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การวาดเส้นโค้งด้วยเคร่ืองมอื 2 Point Arc 
เคร่ืองมือ 2 Point Arc เป็นช่ือเรียกใหม่ ซ่ึงช่ือเดิมก่อนเวอร์ชัน่น้ีคือ Arc เคร่ืองมือ 2 Point Arc มีหลกัการ

ท างานคือ ก าหนดเส้นฐาน 2 จุด และข้ึนรูปเส้นโคง้ มีขั้นตอนการสร้างดงัน้ี 

การวาดเส้นโค้งด้วยเคร่ืองมอื 3 Point Arc 

เคร่ืองมือ 3 Point Arc เป็นเคร่ืองมือใหม่ในเวอร์ชั่น 2018 หลกัการท างานคือ ก าหนดจุด 3 จุดท่ีอย่บูนส่วน 

โคง้เดียวกนั หากจุดเร่ิมตน้และจุดปลายเป็นจุดเดียวกนัแลว้ จะไดรู้ปวงกลม การวาดส่วนโคง้แบบก าหนด 3 จุด 

มีขั้นตอนการสร้างดงันี้ 
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การวาดเส้นโค้งด้วยเคร่ืองมอื Pie  
เคร่ืองมือ Pie มีการใชง้านเหมือนกบัเคร่ืองมือ Arc ทุกอยา่ง เพียงแต่ผลท่ีไดคื้อส่วนของวงกลมท่ีเป็นพื้นท่ีปิด 
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วตัถุ 3 มติ ิ( 3D Model ) 

วตัถุ 3 มิติ หรือ 3D Model คือ วตัถุท่ีถูกสร้างโดยโปรแกรมคอมพิวเตอร์เพื่อแสดงผล ให้เห็นบนพื้นผิวท่ี 3
มิติ คือมีมิติในแนวนอน แนวตั้ง และแนวลึก ซ่ึงแตกต่างจากภาพ 2 มิติ ท่ีแสดงผลเพียง 2 แนวเท่านั้น วตัถุ 3 มิติ จึงมี
มุมมองท่ีมากกวา่ คือสามารถมองเห็นไดร้อบดา้น 360 องศา และสามารถปรับแต่งแกไ้ขรูปทรงในลกัษณะเหมือนกบั
งานป้ันได ้ซ่ึงเรียกวา่ 3D Modeling หรือการป้ันวตัถุ 3 มิติ 

ส่วนประกอบ 3D Model  
วตัถุ 3 มิติ แบบ Polygonal มีส่วนประกอบ ดงัน้ี  
1.Face : คือ พื้นผวิแต่ละดา้นของวตัถุ

2.Edge : คือ เส้นขอบแต่ละดา้นของวตัถุ

3.Vertice หรือ Vertex : คือ จุดเช่ือมต่อของเส้นและพื้นผิว

เคร่ืองมือเคลือ่นย้ายวตัถุ Move 

เคร่ืองมือเคล่ือนยา้ยวตัถุม่ีช่ือว่า Move สามารถใช้งานไดม้ากกวา่การเคล่ือนยา้ยวตัถุช้ินใดช้ินหน่ึงเท่านั้น 

เคร่ืองมือน้ียงัประยุกต์ใช้ในการท าส าเนาวตัถุได้อย่างมีประสิทธิภาพ และใช้แก้ไขรูปทรงวตัถุได้ด้วยนับเป็น

เคร่ืองมือพื้นฐานและสารพดัประโยชน์ในการสร้างโมเดลช้ินงาน 

การเคลือ่นย้ายทัว่ไป 

ตวัอยา่งน้ีจะเป็นการใชเ้คร่ืองมือเพื่อยา้ยต าแหน่งวตัถุ ซ่ึงเป็นการใชง้านทัว่ไปของเคร่ืองมือน้ี คลิกท่ี
เคร่ืองมือ Move จากนั้นคลิกเลือกวตัถุท่ีตอ้งการยา้ย  ยา้ยวตัถุ ไปยงัต าแหน่งใหม่ 
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การเคลือ่นย้ายและท าส าเนา  
ตวัอย่างนี้จะเป็ นการใชเ้คร่ืองมือยา้ยเพื่อท าส าเนาวตัถุ และก าหนดระยะห่างท่ีแน่นอนจากวตัถุตน้ฉบบั หรือเรียกว่า 

การท า Linaer Arrays 
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เคร่ืองมอืหมุนวตัถุ Rotate 

เคร่ืองมือ          Rotate ใชส้ําหรับหมุนช้ินส่วนตามแกนท่ีก าหนด หากเราหมุนชิ้นส่วนเดียว กใ็ชเ้คร่ืองมือ 

Rotate หมุนโดยตรง แต่ถา้จะหมุนหลายช้ินส่วนก็ตอ้งใชเ้คร่ืองมือ  Select คลิกเลือกช้ินส่วนท่ีตอ้งการก่อน แลว้
จึงใชเ้คร่ืองมือ Rotate  

เคร่ืองมือ Rotate ยงัประยกุตใ์ชใ้นการท าส าเนาวตัถุแนวโคง้ไดอี้กดว้ย ซ่ึงเรียกวา่ Radial Arrays 
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การใช้ Rotate หมุนวตัถุ  
ตวัอยา่งน้ีจะเป็นการใช ้Rotate หมุนวตัถุ โดยมีจุดหมุนคือตวัวตัถุเอง 
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การใช้ Rotate Tool ท าส าเนาวตัถุแนวโค้ง  
ดว้ยวธีิการเดียวกนักบัการยา้ยวตัถุแนวโคง้นี้ หากเรากดปุ่ม <Ctrl> คา้งไวใ้นขณะนั�น กจ็ะเป็นการท าส าเนา
วตัถุไปดว้ย 

เคร่ืองมอืปรับขนาดวตัถุ Scale 

เคร่ืองมือปรับขนาดวตัถุมีช่ือวา่ Scale มีหนา้ท่ีเปล่ียนขนาดหรือสเกลจากวตัถุตน้ฉบบัใหย้อ่หรือขยายใหญ่
ข้ึน ซ่ึงการเปล่ียนสเกลน้ีจะเป็นการเปล่ียนแปลงขนาดของวตัถุจริง ไม่ใช่การซูมขยายหรือยอ่มุมมอง  
การก าหนดสเกลท่ีจะยอ่หรือขยายนั้น เราสามารถใชเ้มาส์กะขนาดคร่าว ๆ หรือก าหนดค่าท่ีแน่นอนในการปรับได ้
และสามารถเปล่ียนสเกลในทางตรงกนัขา้ม หรือเรียกวา่ Mirroring ผลท่ีไดคื้อวตัถุจะอยูใ่นทิศทางกลบัดา้น หรือ
กลบัหวักลบัหาง  

การใช้ Scale Tool ปรับขนาดโดยรักษาอตัราส่วน  
ตวัอยา่งน้ีจะเป็นการปรับขนาดวตัถุโดยรักษาอตัราส่วนของรูปทรงไม่ใหผ้ดิไปจากเดิม 
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เคร่ืองมือผลกัและดงึวตัถุ Push/Pull 

เคร่ืองมือผลกัและดึงพื้นผวิวตัถุมีช่ือวา่ Push/Pull เป็นเคร่ืองมือท่ีใชป้รับแต่งรูปทรงวตัถุ ใหมี้ปริมาตร
เพิ่มข้ึนหรือลดลง มกัใชใ้นการข้ึนรูปวตัถุจากรูปทรง 2 มิติ เช่น รูปส่ีเหล่ียม ใหก้ลาย เป็นรูปทรง 3 มิติ คือกล่อง
ส่ีเหล่ียม เป็นตน้  

เคร่ืองมือ Push/Pull สามารถประยกุตใ์ชไ้ดม้ากมาย และนบัวา่เป็นเคร่ืองมือท่ีโดดเด่น ของ SketchUp ท่ีท า

ใหก้ารข้ึนรูปโมเดลนั้นรวดเร็วมาก และไม่ยุง่ยากเหมือนโปรแกรมสร้างงาน 3 มิติอ่ืนๆ 

การใช้ Push/Pull กบัพืน้ผวิทัว่ไป  
เคร่ืองมือ Push/Pull สามารถใชก้บัพื้นผวิปิดทัว่ไปได ้ไม่วา่จะรูปทรงเป็นส่ีเหล่ียมหรือโคง้ ก็ตาม 

การใช้ Push/Pull เพิม่ความซับซ้อนให้พืน้ผวิ 
ระหวา่งการสร้างปริมาตรเราสามารถเพิ่มความซบัซอ้นให้กบัปริมาตรไดโ้ดยการแบ่ง Segments ของวตัถุ 

เพื่อการปรับแต่งรูปทรงท่ีซบัซอ้นมากข้ึน 
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การใช้ Push/Pull Tool เจาะวตัถุ 
นอกจากจะใชใ้นการเพิ่มปริมาตรแลว้ Push/Pull ยงัสามารถใชเ้จาะวตัถุไดอี้กดว้ย ดว้ยเง่ือนไขว่า วตัถุท่ี

จะเจาะนั้นตอ้งมีพ้ืนผวิท่ีขนานกนั ตวัอย่างง่าย ๆ คือการเจาะก าแพง เพื่อเป็นช่องประตู 
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 เคร่ืองมอืสร้างขอบขนาน Offset 

เคร่ืองมือสร้างขอบขนานมีช่ือวา่ Offset มีไวเ้พื่อสร้างเส้นหรือพื้นผวิท่ีมีลกัษณะ ขนานกบัเส้นหรือพื้นผวิท่ี

อา้งอิง ซ่ึงประยกุตใ์นการสร้างช้ินงานได ้เช่น การสร้างขอบประตู หรือหนา้ต่าง เป็นตน้ 

การใช้ Offset Tool กบัเส้นและพืน้ผวิทัว่ไป  
ตวัอยา่งน้ีจะเป็นการสร้างขอบขนานจากเส้นและพื้นผวิดว้ยเคร่ืองมือ Offset  
การใช้ Offset Tool กบัเส้น  
Offset Tool สามารถใชก้บัเส้นท่ีต่อเน่ืองในระนาบเดียวกนัได ้ขั้นตอนมีดงัน้ี 
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การใช้ Offset Tool กบัพืน้ผวิ  
Offset Tool สามารถใชก้บัพื้นผวิปิดใด ๆ ได ้ขั้นตอนมีดงัน้ี 

 เคร่ืองมอืสร้างวตัถุตามเส้นทาง Follow Me 

เคร่ืองมือ Follow Me เป็นเคร่ืองมือท่ีมีเอกลกัษณ์ในการใชง้าน คือจะสร้างรูปทรงต่าง ๆ ไปตามเสน้ทางที� 

ก าหนดนิยมนําไปใชส้ร้างโมเดล เช่น ราวระเบียง บวัเชิงเสน้ รางน้ าฝน ซ�ึงตวัอย่างต่าง ๆ จะท าใหเ้ขา้ใจการใชง้าน 

มากขึ้น 
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การใช้ Follow Me แต่งขอบวตัถุ  
ตวัอยา่งแรกจะเป็ นการแต่งขอบวตัถุใหเ้ป็ นไปตามเส้นท่ีเราวาด 
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การใช้ Follow Me สร้างรูปทรงด้วยการวนรอบ 
ตวัอยา่งน้ีจะเป็นการสร้างรูปทรงไดด้ว้ยการวนรอบของเคร่ืองมือ Follow Me 
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 เคร่ืองมอืสร้างข้อความ Text 

เคร่ืองมือ Text เป็นเคร่ืองมือท่ีใชส้ร้างขอ้ความกํากบัส่วนต่าง ๆ ของช้ินงาน ซึ� งมีประโยชนม์าก เม่ือชิ้นงาน 

มีรายละเอียดท่ีตอ้งการบ่งชี้ ซึ� งขอ้ความต่างๆ ไดแ้ก่ ช่ือชิ้นงาน, ขนาด, พื้นท่ี หรือขอ้ความอ่ืนๆ 

การสร้างและแก้ไขข้อความ 
ตวัอยา่งน้ีจะเป็นเคร่ืองมือ Text ในการสร้างขอ้ความพร้อมเส้นช้ีไปยงัส่วนของช้ินงาน ซ่ึงมีขั้นตอนดงัน้ี 

หน้าต่างจดัการวตัถุส าเร็จรูป Components 

Component คือวตัถุส าเร็จรูปท่ีไดจ้ากการวาดของเราเองและบนัทึกไว ้ หรือเป็นวตัถุ ท่ีดาวนโ์หลดเพิ�มเติม 

จาก 3D Warehouse คุณสมบติัของ Component คือสามารถเรียกใชแ้ละวางบนพื้นท่ีท างานไดท้นัที โดยไม่ตอ้งวาด 

ใหม่ทุกคร้ัง เป็นเหมือนการเรียกใชส้ าเนาของวตัถุนั้นนั่นเอง

Components เป็นหนา้ต่างท่ีรวบรวม Component ต่าง ๆ ไวเ้พื่อดูขอ้มูล และใชใ้น การเลือกแกไ้ขคุณสมบติั

ของ Component ดว้ย ในหวัขอ้น้ีจะศึกษาการจดัการ Component ดว้ยหนา้ต่าง Components 
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ส่วนประกอบของ Components 
ส่วนประกอบของหนา้ต่าง Components (เรียกใชจ้ากเมนู Window เลือก Components) จะมีส่วนประกอบ

ต่าง ๆ ดงัน้ี 

การเรียกใช้ Components 
การเรียกใช ้Component จากหนา้ต่าง Components มีขั้นตอนดงัน้ี 
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